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Aluksi

Tama opas on tarkoitettu tilastollisen tutkimuksen tekemisen oppaaksi, kun toteu-
tuksessa kdytetddn IBM SPSS Statistics -ohjelmistoa. Téassd oppaassa on pdivitetty
aiemmin tehtyd opasta Ohjeita tilastollisen tutkimuksen toteuttamiseksi SPSS for
Windows-ohjelmiston avulla, joka on tehty vuosien varrella Tampereen yliopistossa
pitdmieni tilastotieteen peruskurssien yhteydessa tapahtuneiden SPSS-ohjelmiston
kiyton opetuksen seka erillisten SPSS-kurssien pohjalta. Oppaassa kiinnitetdin eri-
tyistd huomiota analyysin oikeaan valintaan ja tulosten tulkintaan. Eri toimintojen
teknistd toteuttamista ei esitelld kovin yksityiskohtaisesti, vaan annetaan ohjeet siitd,
mistd haluttu analyysi 16ytyy. Ohjeistus on tehty ohjelmistoversion 23 mukaisesti,
mutta soveltuu hyvin myos muille versioilla. Tarvittaessa teknisid oppaita sekid
online-kursseja 10ytyy lukuisia.

Lukijalta edellytetddn perustietoja tilastotieteestd, mutta toisaalta opasta voi
kayttdd vaikka tiedot olisivatkin melko vihiiset. Opas tarjoaakin mahdollisuuden
tietojen ajan tasalle saattamiseksi sekd tdydentdmiseksi, silld oppaassa esitelldén ly-
hyesti my0s tilastotieteen perusteita. Opas soveltuu tilastollisen analyysin tekemisen
tueksi silloin, kun kéytetdin tavanomaisempia tilastollisia analyyseji. Tilastotieteen
teorian perinpohjainen hallitseminen ei siis ole oppaan kédyton kannalta tarpeellista.
Opas on paremminkin pyritty kirjoittamaan soveltajan nikokulma huomioiden.
Pyritdén siis avustamaan tutkijaa menetelmien valinnassa ja ohjelmiston antamien
tulosten tulkinnassa.

Esimerkeissi kiytetyt aineistot kuvauksineen ovat saatavilla (ks. liite), joten
lukija voi itse tehdid esimerkkien analyysit. Opas on kirjoitettu siten, ettd parhaan
hyodyn siitd saa tekemalld kaikki oppaassa olevat esimerkit peridkkéin aloittaen
esimerkistd 1. Jos lukijalla ei ole kdytossdéin SPSS-ohjelmistoa, hén voi ladata IBM
SPSS Statistics -kokeiluversion 14 pdivin koekéyttoon sivulta https://www.ibm.
com/analytics/us/en/technology/spss/spss-trials.html.

Tdmi opas on saatavana myOs versiona, jossa joihinkin tidssd esiteltyihin
esimerkkeihin on lisitty sekd R- ettd MATLAB-toteutukset. Lukija voi halutessaan
siis katsoa, milld tavalla SPSS-ohjelmistolla tehdyn analyysin voi tehdi niilla
ohjelmilla.

Jarmo Niemeld on auttanut erinomaisella ammattitaidolla raportin LaTeX-
muotoon tyostamisessa.

Tampereella 19. kesdkuuta 2017

Raija Leppéld
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1 Johdanto

Tilastollinen analyysi voidaan karkeasti jakaa kuvailevaan analyysiin ja tilastolli-
seen inferenssiin (paittelyyn). Kuvaileva osuus pyrkii kuvailemaan tietoaineistoa
erilaisten graafisten esitysten ja tunnuslukujen sekd taulukoiden avulla. Tilastollinen
paittely késittelee johtopéitelmien tekoa populaatiosta aineiston (otoksen) perus-
teella. Inferenssi perustuu todenndkoisyysjakaumiin ja niiden hyviksi kdyttoon
erilaisten testien ja analyysien yhteydessa.

Tédssd monisteessa esitellddn lyhyesti joitain analysointimenetelmii, annetaan
ohjeita menetelmén valinnasta ja analyysin suorittamisesta IBM SPSS Statistics
-ohjelmiston avulla seka tulkitaan esimerkeissd saatuja tuloksia. Lahdetéddn liikkeelle
aineiston tallennuksesta, muokkauksesta ja kuvailusta. Sitten tutustutaan joihinkin
testeihin ja menetelmiin, joita voidaan kiyttéd tilastollisen tutkimuksen teossa.

IBM SPSS Statistics -ohjelmisto on helppokiyttoinen, valikko-ohjattu tilastol-
linen ohjelmisto, jolla on mahdollista suorittaa empiirisen aineiston tallennus ja
muokkaus seka tilastolliset analyysit graafisine esityksineen. Ohjelmisto sisaltdd
hyvin laajan valikoiman analysointimenetelmid aina aineiston kuvailuun liittyvisti
menetelmistd epidparametrisiin testeihin, monimuuttujamenetelmiin, epélineaarisiin
malleihin ja aikasarja-analyysiin.

Vaikka tidssd oppaassa oheistus on tehty ohjelmistoversion 23 mukaisesti, niin
se soveltuu hyvin myos muille versioille.

2 SPSS-ymparisto

Kun SPSS-ohjelmisto kdynnistetiin, niin voidaan luoda tyhja havaintomatriisipohja
(New Dataset). Talloin avautuu Data Editor -ndkymad, jossa on kaksi vililehtea:
Data View (havaintomatriisi), Variable View (muuttujien méaaritysikkuna). Lisdksi
saadaan automaattisesti Output-ikkuna, jonne tulostuvat kaikki tehtyjen analyysin
tulokset.

Paavalikko, jonka avulla kayttdja pyytdd ohjelmistoa suorittamaan toiminnot,
sisdltdd mm. seuraavat kohdat:

File Havaintomatriisin luominen, avaaminen, tallennus, tulostaminen, ohjelmiston
kdyton lopetus

Data Havaintomatriisiin liittyvien médritysten teko, kuten ehdollistaminen

Transform Muunnosten teko muuttujille, uusien muuttujien madrittiminen ole-
massa olevien muuttujien avulla, muuttujien luokitusten teko

Analyze Valitaan haluttu analyysi

Graphs Graafisten esitysten tekeminen (esim. jakaumat, pisteparvet, laatikko-jana
-kuviot)

Seuraavassa esitellddn ndiden valikoiden kayttod tilastollisen tutkimuksen teon
edetessi aineiston tallennuksesta analysointeihin. Lihdetiin siis liikkeelle havain-
toaineiston talletuksesta ja muokkauksesta. Kun aineisto on talletettu, voidaan
aineiston analysointi aloittaa jakaumien teolla ja tunnuslukujen laskulla. Kuvaile-
van osuuden jilkeen on vuorossa tilastollisten analysointien teko riippuvuuksien



selvittimiseksi. Suoritettaessa analyysid valitaan tilanteeseen sopiva komento, jon-
ka jalkeen ohjelmisto pyytid tarvittavat tiedot. Annetaan muuttuja tai muuttujat,
joita analyysissd kdytetddan. Muuttujat valitaan esilld olevasta muuttujaluettelosta.

3 Havaintomatriisin luominen,
muokkaaminen ja ehdollistaminen

Empiirisen aineiston eritysmuotona kéytetddn havaintomatriisia. Jos tilastoyk-
sikdiden lukumiird on n ja muuttujien lukuméaérd on p, niin havaintomatsiisi
muodostetaan muuttujien arvoista tilastoyksikoittdin seuraavasti:

X1 X2 ... Xj ... Xp
a | X1 X2 ... Xtj o o... Xip
az | X1 X222 ... X2 ... X2p
a; | Xi1 X2 ... xij Ce xip
an .X:nl an .« o an PN an

missa x;; on i. tilastoyksikon mittaluku ominaisuudelle x;. Muuttujan x; jakauma
on j. pystyrivi eli sarake havaintomatriisissa. Tilastoyksikon a; havaintovektori on
i. vaakarivi.

Muuttujia on kahdenlaisia: kvalitatiivisia (kategorisia) ja kvantitatiivisia (nu-
meerisia). Kvalitatiivinen mittaaminen on vain laadullista mittaamista ja se voidaan
jakaa nominaali- eli luokitteluasteikolliseksi ja jérjestys- eli ordinaaliasteikol-
liseksi mittaamiseksi. Kvantitatiivinen mittaaminen on numeerista mittaamista,
mitta-asteikkoina intervalli- ja suhdeasteikko sekd absoluuttinen asteikko.

Kasiteltidva aineisto on aluksi saatettava havaintomatriisimuotoon, joka siis
on kaksiulotteinen taulukko, jossa médritellddn sarakkeille muuttujat ja kirjataan
riveille tilastoyksikoittdin mittaustulokset. Tilastoyksikoitd ei havaintomatriisiin
tarvitse nimetd, mutta identifioiva tunnusmuuttuja (vaikka juokseva numero) on
useimmiten syyti olla, jotta tarvittaessa 10ydetddn vastaavuus aineiston ja talletetun
havaintomatriisin vélilla.

Uuden havaintoaineiston talletus aloitetaan muuttujien méérityksillda Variable
View -ikkunassa. Miiritellddn muuttujan nimi (lyhyesti, ei erikoismerkkeji), tyyppi
(yleensd numeerinen), ndkyvien desimaalien lukuméari, selitteet muuttujalle ja sen
koodeille.

Kun muuttujat on médritelty, syotetddn arvot muuttujille jokaiselta tilastoyk-
sikoltda Data View -vililehdelld. Jos tietoja puuttuu, niin kyseiset solut jitetdin
tyhjiksi. Talloin ohjelmisto tulkitsee sen puuttuvaksi tiedoksi eikd kéyttdjan yleensi
tarvitse huolehtia puuttuvan tiedon kisittelysté, koska ohjelmisto jittdd sen pois
analyyseistd. Joissain graafisissa esityksissd oletusarvoisesti tulee puuttuvan tiedon
ryhmé mukaan. Sen saa lisamairityksillad pois.

Olemassa olevan havaintomatriisin avaaminen ja myds uuden luominen voidaan
tehdd valikosta



File »
New » Data... uuden luominen

Open » Data... vanhan avaaminen (oletusarvoisesti nikyvit .sav-tunnis-
teella olevat, voi avata myos Excel-tiedostot)

Read Text Data... tekstitiedoston lukeminen

Aineistoa Excel- tai tekstitiedostosta luettaessa voivat muuttujien nimet olla ensim-
madiselld rivilld, jolloin tieto tistd annetaan tiedoston avaamisen yhteydessa.

Usein tarvitaan uusia laskennallisia muuttujia. Uuden muuttujan tekeminen
havaintomatriisissa olemassa olevien muuttujien avulla (esimerkiksi summat,
erotukset, suhteet, mittayksikon vaihdot) suoritetaan valikosta

Transform » Compute Variable... Avautuvassa ikkunassa nimetdin uusi muut-
tuja (Target Variable) ja miiritellddn laskukaava (Numeric Expression).

Muuttujille voidaan tehdd muunnoksia myos kiytettavissi olevien erilaisten funk-
tioiden avulla. Joissain tilanteissa kéyttokelpoinen muunnos on logaritmonti.

Esimerkki 1. Tarkastellaan Rasvaprosentti-aineistoa. Muutetaan paino kilogram-
moiksi ja pituus metreiksi sekd lasketaan painoindeksit. Téalloin tehdddn kolme
uutta muuttujaa: Target Variable on Paino_kg ja Numeric Expression 0.454 « paino,
Target Variable on Pituus_m ja Numeric Expression 0.0254 = pituus, Target Variable
on Painoindeksi ja Numeric Expression (Paino_kg)/(Pituus_m  Pituus_m).  ®

Joskus halutaan analysoida aineistoa valitsemalla késittelyyn mukaan vain
tietyt tilastoyksikot (esimerkiksi aineistossa olevat kaksiot). Voidaan myos haluta
tehdd analyysit jonkun muuttujan ryhmissi (esimerkiksi keskustassa ja keskustan
ulkopuolella oleville asunnoille). Namai ehdollistamiset tehdddn ennen analyysien
tekoa. [lmoitetaan ohjelmistolle, ettd jatkossa halutaan analysoinnit tehtdvin jon-
kun muuttujan (tai muuttujien) eri luokissa erikseen tai tietyn ehdon tiyttiville
tilastoyksikoille.

Ryhmittdinen tarkastelu méairitelldsin valikosta

Data » Split File... vaihtoehto Compare groups ja valitsemalla muuttujaluette-
losta ryhmittelymuuttuja; ryhmittelyn purkaminen vaihtoehto Analyze all
cases, do not create groups.

Tamin mairityksen jilkeen tehtdvit analyysit tapahtuvat erikseen kaikissa ehto-
muuttujan ryhmissd (my0s puuttuvien tietojen ryhmaéssi) erikseen. Jos ehtomuuttuja
on kvantitatiivinen, se on ensin luokiteltava halutulla tavalla. Tama madritys jirjes-
tdd havaintomatriisin uudelleen ryhmittelymuuttujan mukaan. Tisti saattaa olla
haittaa, jos aineistoon ei ole talletettu havaintoja identifioivaa muuttujaa.

Vain tiettyjen tilastoyksikdiden mukaan ottaminen analysointeihin mééritelldén
valikosta

Data » Select Cases... valitsemalla If condition is satisfied ja méiérittelemalla
sopivan if-ehdon. Ehdon purku All cases.


http://www.sis.uta.fi/tilasto/tiltp_aineistoja/rasvaprosentti.sav

4 Muuttujien jakaumat ja tunnusluvut

4.1 Jakaumat

Kun havaintomatriisi on kunnossa, voidaan aineiston analysointi aloittaa. Ensin
muodostetaan muuttujien frekvenssijakaumat (suorat jakaumat) joko graafisesti
tai taulukkona. Muuttujien jakaumista voidaan huomata mahdollisesti tehtyja
tallennusvirheita.

Frekvenssijakauman graafinen esitys valitaan muuttujan mitta-asteikon perus-
teella. Frekvenssihistogrammeja kiytetddn vihintdédn intervalliasteikollisen muut-
tujan jakauman esittdmiseen, pylviitd tai janoja yleensd jarjestysasteikolliselle
muuttujalle ja piirakkakuvioita luokitteluasteikollisen muuttujan tapauksessa.

Graafiset esitykset 10ytyvit valikosta

Graphs » Legacy Dialogs »
Bar... pylvisdiagrammit
Pie... piirakat
Histogram... frekvenssihistogrammit

Esityksen valinnan jilkeen annetaan muuttuja, jolle graafinen esitys tehdaan.

Esimerkki 2. Miesten painoindeksin (esimerkki 1) frekvenssihistogrammi.
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Huomataan, ettd painoindeksin jakauma on oikealle vino. Lisiksi ndhddin, ettd
muutamalla miehelld on hyvin korkea painoindeksin arvo. |



Esimerkki 3. Huoneiden lukuméérin jakauma aineistosta Asunnot_2006.
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Kvantitatiivisen muuttujan yhteydessi luokituksen tekeminen tai kvalitatiivisten
muuttujien tapauksessa luokkien yhdistaminen tapahtuu tekemalld uusi muuttuja
havaintomatriisiin uudelleen koodauksen kautta. Koodaus tapahtuu valikosta

Transform » Recode into Different Variables... annetaan luokiteltava muuttu-
ja (Input Variable), luokituksen seurauksena syntyvian muuttujan nimi (Output
Variable) sekd koodauksen (luokituksen) miérittely (Old and New Values. ..)

Frekvenssijakauman saa taulukkona valikosta

Analyze » Descriptive Statistics » Frequencies...

Esimerkki 4. Luokitellaan asunnot huoneiden lukumaiirin perusteella yksioihin,
kaksioihin sekd kaksioita suurempiin. Muodostetaan uusi muuttuja, joka saa arvot
(1,2 ja 3) huoneiden lukuméérin perusteella. Muodostetaan timén uuden muuttujan
frekvenssijakauma. Jos uudelleen koodauksen yhteydessd on annettu koodeille
selitteet Yksio, Kaksio, Kaksiota suurempi sekd uudelle muuttujalle selite Huoneisto,
saadaan taulukko

Huoneisto
Cumulative
Frequency Percent Valid Percent Percent
Valid  Yksio 31 13,5 13,5 13,5
Kaksio 114 49,8 49,8 63,3
Kaksiota suurempi 84 36,7 36,7 100,0
Total 229 100,0 100,0



http://www.sis.uta.fi/tilasto/tiltp_aineistoja/Asunnot_2006.sav

missd on huoneiden lukumiirin mukaisesti asuntojen lukumairit (Frequency) ja
prosentuaaliset médrat (Valid Percent) sekd kumulatiiviset prosentit (Cumulative
Percent). Siis ldhes puolet myynnissi olleista asunnoista oli kaksioita. ]

Frekvenssitaulukkoa tehtdessd ohjelmisto luokittelee muuttujan jokaisen arvon
omaan luokkaansa riippumatta siitd, montako arvoa muuttujalla on. Tamén vuoksi
kvantitatiivisten muuttujien yhteydessa taulukko on useimmiten kiyttokelpoinen
vasta, kun muuttuja on ensin luokiteltu.

Esimerkki 5. Tarkastellaan miesten painoindekseji. Luokitellaan painoindeksi
luokkiin alle 25, 25-30, 30-35, yli 35. Kun uudelleen koodauksen yhteydessi on
annettu selitteet koodeille Normaalipainoinen, Lievd ylipaino, Merkittdvd ylipaino,
Sairaaloinen lihavuus sekid uudelle muuttujalle selite Lihavuus, saadaan seuraava
taulukko

Lihavuus
Cumulative
Frequency Percent Valid Percent Percent
Valid Normaalipainoinen 125 49,6 49,8 49,8
Lieva ylipaino 102 40,5 40,6 90,4
Merkittava lihavuus 21 8,3 8,4 98,8
Sairaaloinen lihavuus 3 1,2 1,2 100,0
Total 251 99,6 100,0
Missing System 1 4
Total 252 100,0

missd on luokitellun painoindeksin mukaan miesten lukumaéérit (Frequency) ja
prosentuaaliset madrat (Valid Percent) sekd kumulatiiviset prosentit (Cumulative
Percent). Huomataan, ettid aineistossa normaalipainoisia on vain puolet. [ ]

Jos aineistossa on puuttuvia tietoja, niin niiden lukumaiiri nakyy frekvenssija-
kaumassa. Kun kiyttdd uudelleen koodausta, niin on syyta tarkistaa, ettd havaintoja
ja puuttuvia tietoja on saman verran kuin alkuperiisessékin muuttujassa.

Esimerkki 6. Esimerkin 4 jakaumasta huomattiin, ettid 1ihes puolet huoneistoista
oli kaksioita. Tutkitaan nyt kaksioiden neliohintoja. Lasketaan aluksi nelichinta
Transform » Compute » Target Variable on Neliohinta ja Numeric Expression
HINTA/NELIOT. Kun halutaan analysoida vain kaksioita, niin méiritellddn en-
nen analyysien tekemistd Data-valikossa Select Cases. .. if-ehto Huoneisto = 2.
Verrataan kaksioiden neliohinnan jakaumia alueittain. Annetaan frekvenssihis-
togrammin teon yhteydessd ryhmittelymuuttujaksi Alue (Panel by Rows: Alue).
Saadaan samaan kuvaan kolme frekvenssihistogrammia
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Esimerkki 7. Esimerkin 4 Huoneisto-muuttujan jakauma voidaan tehdi alueit-
tain. Talloin Split file ryhmittelymuuttujaksi annetaan Alue, sitten muodostetaan
frekvenssijakauman muuttujasta Huoneisto, saadaan tulos

Huoneisto
Cumulative
Alue Frequency Percent  Valid Percent Percent
Keskusta  Valid  Yksio 13 12,6 12,6 12,6
Kaksio 58 56,3 56,3 68,9
Kaksiota suurempi 32 31,1 31,1 100,0
Total 103 100,0 100,0
Lansi Valid  Yksid 4 11,8 11,8 11,8
Kaksio 18 52,9 52,9 64,7
Kaksiota suurempi 12 35,3 35,3 100,0
Total 34 100,0 100,0
Ita Valid  Yksid 14 15,2 15,2 15,2
Kaksio 38 41,3 41,3 56,5
Kaksiota suurempi 40 43,5 43,5 100,0
Total 92 100,0 100,0

Paremmin jakaumia voidaan kuitenkin verrata ristiintaulukoimalla muuttujat, (ks.
esimerkki 12) tai kdyttamailld tilanteeseen sopivaa graafista esitysti (ks. esimerkki 8).
|

Esimerkki 8. Tarkastellaan graafisesti esimerkin 4 Huoneisto-muuttujan jakaumia
alueittain. Piirretdin pylvdasdiagrammit Graphs » Legacy Dialogs » Bar... Stacked,
Category Axis: Alue, Define Stacks by: Huoneisto, kidnnetidin ne vaakatasoon ja
pyydetiin prosenttijakaumat alueittain. Saadaan kuvaaja
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Huomataan, ettid jakaumissa on jonkin verran alueellisia eroja. [

4.2 Tunnuslukuja

Tunnusluvun avulla pyritdin kuvaamaan muuttujan jakaumaa muuttujan arvoista
lasketulla luvulla. Kuvataan esimerkiksi jakauman sijaintia sopivan keskiluvun
avulla tai muuttujan arvojen vaihtelua hajontaluvun avulla. Muuttujan mitta-asteikko
madrittdd sen, mitd tunnuslukuja jakauman kuvaamiseen voidaan kayttia.

Keskilukuja ovat moodi, mediaani ja keskiarvo. Moodi on se muuttujan arvo tai
luokka, joka esiintyy useimmin tai jossa on eniten havaintoja. Mediaani on sellainen
muuttujan arvo, jota pienempid ja suurempia arvoja on yhtd paljon. Mediaania
voidaan kayttdd, kun jarjestykselld on tulkinta eli muuttuja on vihintdin jéarjes-
tysasteikollinen. Aritmeettinen keskiarvo on sallittu kvantitatiivisten muuttujien
yhteydessa.

Muuttujan arvot vaihtelevat tilastoyksikosti toiseen. Vaihtelun voimakkuutta
pyritddn mittaamaan erilaisia tunnuslukuja kiyttden. Kvantitatiivisten muuttujien
yhteydessa vaihtelua mitataan varianssin avulla. Varianssi mittaa kuinka tiiviisti
muuttujien arvot ovat keskittyneet keskiarvon ympirille. Varianssin nelidjuuri on
nimeltddn keskihajonta, joka useimmiten ilmoitetaan vaihtelun mittarina.

Ala- ja yldkvartiili ovat mediaanin kaltaisia tunnuslukuja, jotka kuvaavat
jakauman sijaintia. Alakvartiili on luku, joka jakaa muuttujan arvot kahteen osaan
siten, ettd korkeintaan 25 % havaituista arvoista on pienempid kuin alakvartiili.
Ylikvartiili on luku, joka jakaa muuttujan arvot kahteen osaan siten, etti korkeintaan
75 % havaituista arvoista on pienempia kuin yldkvartiili. Alakvartiili, mediaani ja
yldkvartiili jakavat muuttujan arvot neljdin havaintomaériltaan yhtd suuriin osiin.
Yhdessi nditd tunnuslukuja kutsutaan kvartiileiksi. Muuttujan arvot voidaan jakaa
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viiteen, kuuteen, jne. havaintomadriltaan yhtd suuriin osiin. Yleisesti niitd osiin
jakavia tunnuslukuja kutsutaan fraktiileiksi.

Tunnuslukuja voidaan tarkastella ehdollisina. Ehdollisia keskiarvoja (tai mediaa-
neja) voidaan kéyttii tutkittaessa riippuvuutta kahden muuttujan vélilld. Ehdollisten
keskiarvojen kiytto riippuvuuden tutkimisessa edellyttda tietysti siti, ettéd selitettiva
muuttuja on kvantitatiivinen.

Jakaumaa kuvaavia erilaisia tunnuslukuja saadaan mm. seuraavilla tavoilla:

Analyze »

Descriptive Statistics »
Frequencies... saadaan halutuista muuttujista mm. keskiarvo, medi-
aani, fraktiilit, moodi, keskihajonta, varianssi, pienin arvo, suurin
arvo

Descriptives... saadaan halutuista muuttujista mm. keskiarvo, keski-
hajonta, varianssi, pienin arvo, suurin arvo, vaihteluvili

Explore... saadaan halutuista muuttujista mm. keskiarvo, keskihajonta,
varianssi, pienin arvo, suurin arvo, vaihteluvili sekd tunnusluvut
ehdollisina antamalla kohdassa Factor List ryhmittelymuuttuja

Compare Means »

Means... saadaan tunnusluvut ehdollisina antamalla ehtomuuttuja
kohdassa Independent List

Esimerkki 9. Painoindeksin sekd huoneiden lukumaéérén tunnuslukuja (pyydetty
keskiarvo, mediaani, keskihajonta, pienin ja suurin arvo, alakvartiili, mediaani,
ylékvartiili)

Statistics Statistics

Painoindeksi Huoneita
N Valid 251 N Valid 229

Missing 1 Missing 0
Mean 25,4086 Mean 2,31
Median 25,1045 Median 2,00
Std. Deviation 3,66131 Std. Deviation ,823
Minimum 18,03 Minimum 1
Maximum 48,96 Maximum 6
Percentiles 25 23,0564 Percentiles 25 2,00

50 25,1045 50 2,00

75 27,3526 75 3,00

Histogrammin teon yhteydessd saa muuttujan keskiarvon ja keskihajonnan
automaattisesti (ks. esimerkki 2).

Ehdollisia jakaumia voidaan havainnollistaa myds laatikko-jana -kuvion (box-
plot) avulla. Kuvio perustuu fraktiileihin ja saadaan tehdyksi valikosta

Graphs » Legacy Dialogs » Boxplot... antamalla Variable-kohtaan tutkittava
muuttuja ja Category-kohtaan ryhmittelymuuttuja.
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Esimerkki 10. Vaikuttaako sijainti asunnon nelidhintaan? Asunnon nelichinta (las-
kettu esimerkissd 6) on selitettdva eli riippuva muuttuja (y) ja sijainti (Alue) selittavi
eli riippumaton muuttuja (x). Pyritdédn selvittimaéan Neliohinta-muuttujan arvojen
vaihtelua silld, milld alueella huoneisto sijaitsee. Erds mahdollisuus riippuvuuden
selvittimisessd on keskiarvojen vertailu ryhmittiin, ehdollisten keskiarvojen kiytto.
Lasketaan Neliohinta-muuttujasta keskiarvot alueittain sekd vertaillaan keskiarvo-
eroja. Jos ehdolliset keskiarvot poikkeavat toisistaan sanotaan, ettd Alue-muuttujalla
voidaan selittdd Neliohinta-muuttujan vaihtelua. Sanotaan, ettd Neliohinta-muut-
tuja riippuu Alue-muuttujasta. Jos ehdolliset keskiarvot ovat lihes samoja, niin
riippuvuutta ei ole. Ehdolliset keskiarvot lasketaan valikosta Compare Means »
Means. .. antamalla Dependent List -muuttujaksi Neliohinta ja Independent List
-muuttujaksi Alue. Ndin saadaan tulos

Nelidhinta

Alue Mean N Std. Deviation
Keskusta  2397,6072 103 408,02462
Lansi 1414,2870 34 260,39544
Ita 1536,1328 92 341,69439
Total 1905,5176 229 575,61088

jossa on ehdolliset keskiarvot (Mean) ja keskihajonnat (Std.Deviation). Niyttaisi
siis siltd, ettd keskustan nelidhinnat ovat keskimédrin korkeampia kuin keskustan
ulkopuolella (ks. testaus 6.2). Neliohinnan jakaumissa esiintyvé vaihtelu on myos
jonkin verran erilaista, keskustassa keskihajonta on suurin. Tama nékyy hyvin myos
laatikko-jana -kuviosta
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joka on tehty valikosta Graphs » Boxplot... antamalla Variable-kohtaan Nelio-
hinta ja Category-kohtaan Alue. Laatikko-jana -kuviossa keskimmadinen viiva on
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neliohinnan mediaanin kohdalla ja laatikon yli- ja alareunat yli- ja alakvartiileissa.
Ylimmat ja alimmat viivat ovat suurimpien ja pieneimpien arvon kohdalla, ellei
ryhmissi ole poikkeavia arvoja. Kuviosta ndhdiin, ettd keskustassa neliohinnan
jakauma on ylempénd kuin muilla alueilla ja siind on myds enemmin vaihtelua.
Keskustassa on myds muutamia kovin kalliita asuntoja. |

S Pisteparvi ja korrelaatiokerroin

Kun tarkastellaan kahta muuttujaa samanaikaisesti, niin on kyse kaksiulotteisesta
jakaumasta. Télloin ollaan kiinnostuneita muuttujien vilisestd riippuvuudesta. Kak-
siulotteisen jakauman graafinen esitystapa on pisteparvi eli korrelaatiodiagrammi,
joka antaa hyvin yleiskuvan mahdollisesta riippuvuudesta ja sen laadusta. Pistepar-
vi on jarkevi piirtdd, kun selitettivd muuttuja on kvantitatiivinen. Tulkinnassa on
huomattava selittivin muuttujan mitta-asteikko. Pisteparvi saadaan valikosta

Graphs » Legacy Dialogs » Scatter/Dot... antamalla selitettdvd y pystyakse-
lille ja selittdava x vaaka-akselille.

Myos kaksiulotteisista jakaumista voidaan mééritelld tunnuslukuja, jotka nyt
mittaavat riippuvuuden voimakkuutta. Yksi tdllainen tunnusluku on korrelaatioker-
roin (r), joka mittaa kahden kvantitatiivisen muuttujan vélisen suoranomaisen eli
lineaarisen riippuvuuden voimakkuutta. Lineaarinen riippuvuus voi olla positiivista
tai negatiivista, korrelaatiokerroin vastaavasti joko positiivinen tai negatiivinen.
Korrelaatiokertoimen ollessa ldhelld nollaa lineaarista riippuvuutta ei ole. Taydel-
linen lineaarinen riippuvuus on silloin, kun korrelaatiokerroin on itseisarvoltaan
yksi. Korrelaatiokertoimen (korrelaatiomatriisin) voi laskea valikosta

Analyze » Correlate » Bivariate... antamalla halutut muuttujat.

Esimerkki 11. Rasvaprosentin ja vyotaron ympéarysmitan riippuvuus.
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Muuttujien vilillda huomataan olevan voimakas suoranomainen riippuvuus. Siis
rasvaprosentti riippuu lineaarisesti vyotaron ymparysmitasta (ks. tarkemmin 6.4).
Korrelaatiomatriisiksi saadaan

Correlations

vyo6taron

rasvaprosentti ympérys(cm)

rasvaprosentti Pearson Correlation 1 ,813**

Sig. (2-tailed) ,000

N 252 252

vyétaron ymparys(cm)  Pearson Correlation 813" 1
Sig. (2-tailed) ,000

N 252 252

**_Correlation is significant at the 0.01 level (2-tailed).

jossa korrelaatiokerroin on 0,813 kertoen voimakkaasta positiivisesta lineaarisesta
riippuvuudesta (ks. testaus 6.4). ]

6 Joitain yleisesti kaytettyja
analysointimenetelmia

Tilastollinen hypoteesi on viittimi populaatiosta, sen jakaumasta tai jakauman
parametrista. Hypoteesin testaus tarkoittaa viittimén tutkimista otoksen perusteella.
Viitteen paikkansa pitidvyyttd tutkitaan otoksen (kiytettdvissd olevan aineiston)
perusteella laskemalla tilanteeseen sopiva testisuure. Tdmén testisuureen arvon pe-
rusteella joko uskotaan viite tai ei uskota (jolloin vaihtoehtoinen viite hyviksytaan).
Johtopéitelmén tekeminen perustuu siihen, ettd selvitetddn voidaanko otoksesta
laskettua testisuureen arvoa viitteen ollessa tosi pitdd tavanomaisten arvojen jouk-
koon kuuluvana vai katsotaanko se harvinaisten arvojen joukkoon kuuluvaksi. Jos
testisuureen arvo kuuluu harvinaisten arvojen joukkoon, niin véitettd ei uskota.
Mika sitten on harvinaista? Testauksessa harvinaisiksi arvoiksi katsotaan sellaisten
arvojen joukko, jonka todennékoisyys on melko pieni. Taimin todenndkoisyyden
kiinnittiminen madrittda testaukseen liittyvén riskitason. Testauksessa on tapana
ilmoittaa nk. p-arvo, joka kertoo todennidkdisyyden saada viitteen ollessa tosi
otoksesta saatua arvoa harvinaisempi arvo. Tdma on pienin ristitaso, jolla asetettu
viite voidaan hylati. Jos siis testaukseen liittyvad p-arvo on pieni, sanotaan vaikka
0,01, niin asetettua vditettd ei uskota, se hylatiin ja hyviksytidin vaihtoehtoinen
vdittdmi. Se milloin p-arvon katsotaan olevan tarpeeksi pieni, riippuu siitd millai-
nen todennikoisyys sallitaan sille, ettd tehddin viird johtopadtelmai; vaira siten,
ettd viittama hyldtdan vaikka sen on tosi. Tami virhetodennikdisyys ei saa olla
suuri, sen halutaan usein olevan suuruusluokkaa pienempi kuin 5 %, 2,5 %, 1 Y%.

Jos p-arvo on pienempi kuin 0,05, on tapana sanoa, etti tulos on tilastollisesti
melkein merkitsevd. Jos p-arvo on pienempi kuin 0,01, sanotaan tuloksen olevan
tilastollisesti merkitsevin ja p-arvon ollessa pienempi kuin 0,001 tilastollisesti
erittdin merkitsevén.

Hypoteesin testauksessa asetetaankin siis kaksi viittimia, joista toinen on
vilttamaittd voimassa. Asetetaan nollahypoteesi Hyp, jonka ollessa tosi, testisuuren
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todennékdisyysjakauma tunnetaan, sekd vaihtoehtoinen hypoteesi H;. Nollahypo-
teesi Hy tulee aina asettaa kiytetyn testin sanelemalla tavalla.

Seuraavaksi esiteltdvissd menetelmissé pyritddn selittdimiidn yhtd muuttuja. Se-
littdvid muuttujia on yksi tai useampia. Analysointimenetelmén valintaan vaikuttaa
muuttujien mittaustaso. Tdssi esityksessd kdydadn 1dpi kolme perusanalyysii.

6.1 Ristiintaulukko ja riippumattomuustesti

Kahden kvalitatiivisen muuttujan vélinen riippuvuustarkastelu voidaan tehda ris-
tiintaulukon avulla vertailemalla selitettdvin muuttujan prosenttijakaumia selittdjan
luokissa. Riippuvuuden merkitsevyys voidaan testata. Testisuureena kiytetdin
)(2—riippumattomuustestisuuretta ja hypoteesit asetetaan

Hy: ei riippuvuutta

H;: on riippuvuutta.

Testin kayttoon liittyy joitain oletuksia (ei kuitenkaan mitta-asteikkovaatimuksia).
Tilanteissa, jossa ristiintaulukointi on tehty siten, ettd molemmilla muuttujilla on
kaksi luokkaa (nelikenttd), testid voidaan kayttda, jos n > 40. Jos nelikentdssd
20 < n < 40, niin nk. teoreettiset frekvenssit (frekvenssit, jos riippuvuutta
ristiintaulukon perusteella ei olisi) eivit saa olla alle viiden. Muulloin kaikkien
teoreettisten frekvenssien oltava suurempia kuin yksi seké enintdén 20 % saa olla
alle viiden. Jos vaatimukset eivit tdyty, muutetaan muuttujien luokituksia.

x’-testisuureen arvot ovat ei-negatiivisia, joten harvinaisten arvojen joukko
muodostuu suurista arvoista.

Ristiintaulukointi ja testaus tehdédén valikosta
Analyze » Descriptive Statistics » Crosstabs... annetaan sarake- ja rivimuut-
tujat, lisimaareina
* Statistics. ..-painike » Chi-square, y?>-testisuure
* Cells...-painike, ehdolliset prosenttijakaumat, “suunta” valitaan siten,

ettd saadaan selitettdvin prosenttijakaumat selittdjan luokissa.

SPSS muodostaa ristiintaulukon siten, ettd molempien muuttujien jokainen
arvo on omana luokkanaan. Kvantitatiivinen muuttuja on siis ensin luokiteltava
(Transform » Recode into Different Variables ...).

Esimerkki 12. Tarkastellaan esimerkin 7 tilannetta. Halutaan selvittda, onko alu-
eella vaikutusta huoneiston tyyppiin.
Nyt asetetaan

Hy: huoneiston tyypin ja alueen vililld ei riippuvuutta

Hi: huoneiston tyypin ja alueen vililld on riippuvuutta.

Suoritetaan edelld esitetyllad tavalla ndiden muuttujien ristiintaulukointi. Saadaan
ristiintaulukko ja testaukseen liittyvit tulokset
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Huoneisto * Alue Crosstabulation

Alue
Keskusta Lansi Ita Total
Huoneisto Yksio Count 13 4 14 31
% within Alue 12,6% 11,8% 15,2% 13,5%
Kaksio Count 58 18 38 114
% within Alue 56,3% 52,9% 41,3% 49,8%
Kaksiota suurempi Count 32 12 40 84
% within Alue 31,1% 35,3% 43,5% 36,7%
Total Count 103 34 92 229
% within Alue 100,0% 100,0% 100,0% 100,0%
Chi-Square Tests
Asymptotic
Significance (2-
Value df sided)
Pearson Chi-Square 4,6742 322
Likelihood Ratio 4,700 319
Linear-by-Linear 1,040 1 ,308
Association
N of Valid Cases 229

a. 1 cells (11,1%) have expected count less than 5. The minimum expected count is 4,60.

Aluksi huomataan, etti Huoneisto-muuttujan prosentuaaliset jakaumat alueittain

poikkeavat jonkin verran toisistaan. Mutta ovatko erot riittdvin suuria, jotta voi-

daan tehdi paitelmai riippuvuuden olemassaolosta? Tuloksesta (kohta a.) nihdédan
ensin, ettd oletuksen testin kdyttoon ovat voimassa (pienin teoreettinen (odotettu)
frekvenssi 4,60, alle viiden teoreettisia frekvensseji 11,1 %). y?-riippumattomuus-
testisuureen arvo (Pearson Chi-Square) on 4,674 ja p-arvo on 0,322, joten H
hyviksytaan. Tehdédédn johtopaitelma, ettd muuttujien vélilld ei ole riippuvuutta. m

Esimerkki 13. Tarkastellaan ARVIO-aineistoa, jossa on eradlti kurssilta saatua
opiskelijapalautetta. Halutaan selvittdd, onko opintosuunnalla vaikutusta annettuun
palautteeseen. Aineistossa on muuttuja Opintojakson tyoldys, joka mittaa kurssin
tyolayttd (muodostettu kurssi-muuttujasta yhdistamalld reunimmaiset luokat), seki
palautteen antajan opintosuunta (Opiskelijan opintosuunta). Nyt asetetaan

Hy: opintosuunnan ja tyoldyden vililld ei riippuvuutta

Hj: opintosuunnan ja ty6ldyden vililld on riippuvuutta.

Saadaan ristiintaulukko ja testaukseen liittyvat tulokset
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Opintojakson tyolays * Opiskelijan opintosuunta Crosstabulation

Opiskelijan opintosuunta

hallinto taloust Total
Opintojakson tydlays  tydlas Count 13 16 29
% within Opiskelijan 68,4% 34,8% 44,6%
opintosuunta
sopiva Count 5 15 20
% within Opiskelijan 26,3% 32,6% 30,8%
opintosuunta
vahatdinen  Count 1 15 16
% within Opiskelijan 5,3% 32,6% 24,6%
opintosuunta
Total Count 19 46 65
% within Opiskelijan 100,0% 100,0% 100,0%
opintosuunta
Chi-Square Tests
Asymptotic
Significance (2-
Value df sided)
Pearson Chi-Square 7,668% 2 ,022
Likelihood Ratio 8,680 2 ,013
Linear-by-Linear 7,548 1 ,006
Association
N of Valid Cases 65

a. 1 cells (16,7%) have expected count less than 5. The minimum expected count is 4,68.

Huomataan, ettd Opintojakson tyoldys -muuttujan prosentuaaliset jakaumat opin-
tosuunnittain poikkeavat paljonkin toisistaan. Mutta ovatko erot riittdvin suuria,
jotta voidaan tehda paitelma riippuvuuden olemassaolosta? Tuloksesta (kohta a.)
nidhdéin ensin, ettd oletuksen testin kidyttoon ovat voimassa (pienin teoreettinen
(odotettu) frekvenssi on 4,68, alle viiden teoreettisia frekvenssejd on 16,7 %).
x>-riippumattomuustestisuureen arvo (Pearson Chi-Square) on 7,668 ja p-arvo
on 0,022. Jos paittely tehdddn 5 %:n riskitasolla, niin Hy hylitddn ja pddtellaan
riippuvuutta olevan. Jos valitaan pienempi riskitaso kuin 2,2 %, niin paitellaan,
ettd riippuvuutta ei ole. ]

Tilastollisten testin suorittaminen tapahtuu periaatteessa kaikissa tilanteissa
edelli esitetylld tavalla. Asetetaan testattava hypoteesi, lasketaan testisuureen arvo
ja pienin riskitaso, jolla nollahypoteesi voidaan hylidtd. Tamén p-arvon perusteella
joko hyviksytddn viittima tai hyldtiddn se. Eri tilanteissa nollahypoteesi, testisuure
ja sen jakauma ovat erilaisia.

6.2 Odotusarvojen yhtasuuruuden testaaminen #-testilla

Tutkittaessa kvantitatiivisen muuttujan riippuvuutta kvalitatiivisesta muuttujasta,
jolla on kaksi luokkaa, voidaan kdyttdd riippumattomien otosten 7-testid kahden po-
pulaation odotusarvojen yhtdasuuruuden testaamiseksi. Tutkitaan siis populaatioiden
keskiarvoja, joita voidaan arvioida otoskeskiarvojen avulla.

Hypoteesit asetetaan

Hy: populaatioiden odotusarvot ovat samoja

H,: populaatioiden odotusarvot eivit ole yhti suuria.
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Vaihtoehtoinen hypoteesi voidaan asettaa my6s yksisuuntaisena, jolloin Hj: toisen
populaation odotusarvo on toista suurempi. Riippumattomien otosten ¢-testissi
oletetaan, ettd kdytossid on riippumattomat satunnaisotokset normaalijakaumista,
joiden varianssit ovat yhté suuret, mutta tuntemattomat. Testisuure, jota kédytetdin,
noudattaa nollahypoteesin ollessa tosi nk. Studentin t-jakaumaa, joka mairitelldan
nk. vapausastein. Tdmai jakauma on symmetrinen origon suhteen. Siis harvinais-
ten arvojen joukko muodostuu kaksisuuntaisessa testissd itseisarvoltaan suurista
arvoista.
Riippumattomien otosten 7-testi saadaan valikosta

Analyze » Compare Means » Independent-Samples T Test... annetaan seli-
tettdva (Test Variable) seka selittava, ryhmittely -muuttuja (Grouping Vari-
able).

Tuloksena saadaan testisuureen lisdksi myos ryhmikeskiarvot ja -varianssit seka
testisuure varianssien yhtdsuuruuden testaamiseksi.

Esimerkki 14. Onko keskustassa ja keskustan ulkopuolella olevien asuntojen
keskimairdisissa nelidhinnoissa eroja?
Asetetaan
Hy: nelichinnan odotusarvot samoja molemmissa populaatioissa
Hi: nelichinnan odotusarvot eivit samoja molemmissa populaatioissa.
Tehdidn tarkastelu esimerkin 10 aineistosta. Suoritetaan riippumattomien otosten
t-testi edelld esitetylld tavalla ja saadaan tulokset

Group Statistics

Onko keskustassa? N Mean Std. Deviation ~ Std. Error Mean
Nelihinta  Eiole 126  1503,2538 325,34129 28,98371
On 103 2397,6072 408,02462 40,20386

Independent Samples Test

Levene's Test for Equality of

Variances t-test for Equality of Means
F Sig. t df Sig. (2-tailed)
Nelidhinta Equal variances assumed 1,235 ,268 -18,455 227 ,000
Equal variances not -18,045 193,029 ,000

assumed

95% Confidence Interval of the

Mean Std. Error Difference
Difference Difference Lower Upper
-894,35342 48,46101 ~089,84436 -798,86248
-894,35342 49,56214 -992,10630 -796,60054

Téssé on siis riippumattomat otokset keskustan ulkopuolelta ja keskustasta. Otos-
koot ovat 126 ja 103. Nelichinnan keskiarvojen erotus on —894,35. Nelichinnan
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otosvarianssit (325,342 ja 408,02%) poikkeavat toisistaan. Nyt tuloksista 16ytyy
testisuure (Levene’s Test for Equality of Variances) hypoteesille Hy: Populaation
varianssit voidaan olettaa samoiksi. Koska tdhin liittyvd p-arvo on 0,268 > 0,05,
Hy hyviksytddn ja todetaan, ettd vaatimus varianssien yhtdasuuruudesta voidaan
kuitenkin olettaa olevan tdytetty. Jos ndin ei olisi, niin 7-testin tulokset luettaisiin
toiselta riviltd. Normaalijakaumaoletus jatetddn tidssa testaamatta. Populaatioiden
odotusarvojen yhtdsuuruuden testaamiseen liittyva z-testisuureen arvo on —18,455
ja kaksisuuntaiseen testiin liittyva p-arvo < 0,001. Jos riskitasoksi valitaan 0,001 %,
niin nollahypoteesi hylétdén ja tehdddn paiatelma, ettd nelichinnat ovat keskiméarin
erisuuruiset.

Tulostuksesta 10ytyy myos 95 % luottamusvili odotusarvojen erotukselle.
Testin sijaan voidaan kayttdad titd luottamusvilid johtopadtelmin tekemisessa.
Jos luottamusvili siséltdd nollan niin populaation odotusarvojen erotus voidaan
arvioida olevan nolla (eli keskustan ulkopuolella ja keskustassa nelidhintojen
odotusarvot samoja). Tédssd luottamusvili, jolle populaatioiden odotusarvojen
erotuksen arvellaan kuuluvan, on (—989,84, —798,86). ]

Esimerkki 15. Onko keskustassa ja keskustan ulkopuolella olevien kaksioiden
keskimairdisissd neliomairissa eroja?
Asetetaan
Hp: neliomédrien odotusarvot samoja molemmissa populaatioissa

Hi: neliomédrien odotusarvot eivit samoja molemmissa populaatioissa.

Tarkastellaan edellisen esimerkin aineistoa. Valiteen analysoitavaksi vain kaksiot
(Data » Select Cases ...) ja suoritetaan riippumattomien otosten z-testi. Saadaan
tulokset

Group Statistics

Onko keskustassa? N Mean Std. Deviation ~ Std. Error Mean
Neliot Ei ole 56 55,05 6,132 ,819
On 58 53,39 6,326 ,831

Independent Samples Test

Levene's Test for Equality of

Variances t-test for Equality of Means
F Sig. t df Sig. (2-tailed)
Neliot ~ Equal variances assumed ,026 ,873 1,428 112 ,156
Equal variances not 1,429 111,998 ,156

assumed
==L

95% Confidence Interval of the

Mean Std. Error Difference
Difference Difference Lower Upper
1,667 1,168 -,646 3,981
1,667 1,167 -,645 3,979
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Populaation varianssit voidaan olettaa olevan samoja, koska varianssien yhtisuu-
ruuden testaamiseen liittyva p-arvo on 0,873 > 0,05. Asetettu Hp hyviksytdan
5 %:n riskitasolla, koska z-testiin liittyvd p-arvo on 0,156. Jos testaus tehtiisiin
yksisuuntaisena, niin p-arvo olisi 0,156/2 = 0,078.

Jos halutaan tehdi pééttely luottamusvilin avulla, niin todetaan nollan kuuluvan
odotusarvojen erotuksen 95 %:n luottamusvilille (—0,646, 3,981) ja piitellaan
odotusarvojen olevan yhtd suuret. ]

6.3 Varianssianalyysi

Tutkittaessa kvantitatiivisen muuttujan riippuvuutta kvalitatiivisesta muuttujasta,
jolla on useampi kuin kaksi luokkaa, voidaan kiyttid yksisuuntaista varianssiana-
lyysid populaatioiden odotusarvojen yhtdsuuruuden testaamiseksi. Tdma on siis
yleistys edelld esitetylle riippumattomien otoksien #-testille. Nytkin testattavana
hypoteesina on

Hy: populaation odotusarvot ovat samoja

H: kaikki odotusarvot eivit ole samoja.

Testin kayttoon liittyy samat oletukset kuin #-testissdkin. On tehty riippumattomat
otokset normaalijakaumista, joiden varianssit yhtd suuret mutta tuntemattomat. Jos
otoksia on kaksi, voi tehdd joko 7-testin tai suorittaa varianssianalyysin.
Varianssianalyysissd kéytetddn nk. F'-testisuuretta odotusarvojen yhtisuuruuden
testaamiseksi. Tamin testisuureen arvot ovat ei-negatiivisia, joten harvinaisten
arvojen joukko muodostuu suurista arvoista.
Varianssianalyysi suoritetaan valikosta

Analyze » Compare Means » One-Way ANOVA... annetaan selitettdvi, riippu-
va (Dependent) muuttuja sekd selittdava (Factor) muuttuja.

Tuloksena saadaan testisuureen lisidksi pyydettdessi (Options...) myos ehdolliset
keskiarvot ja varianssit seki testisuure varianssien yhtdsuuruuden testaamiseksi.
Jos saadaan tulos, ettd odotusarvot eivit kaikki ole yhtisuuria, voidaan myos tehda
monivertailuja ryhmittdin (Post Hoc...). Nimitys yksisuuntainen varianssianalyysi
tulee siitd, ettd on yksi selittdjd. Nimitys varianssianalyysi on hieman harhaanjohtava,
koska analyysissi ei testata varianssien yhtdsuuruutta (paitsi oletusten tutkimisessa)
vaan odotusarvojen yhtdsuuruutta.

Esimerkki 16. Halutaan tutkia, vaikuttaako alue keskimairiiseen neliohintaan.
Nyt

Hp: nelichinnan odotusarvot ovat samoja kaikilla alueilla

Hi: nelichinnan odotusarvot kaikki eivit yhti suuria.

Tehdéin varianssianalyysi edelld esitetylld tavalla esimerkin 10 tilanteesta. Saadaan
tulokset
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Nelidhinta

N Mean Std. Deviation
Keskusta 103  2397,6072 408,02462
Lansi 34  1414,2870 260,39544
Ita 92  1536,1328 341,69439
Total 229  1905,5176 575,61088

Test of Homogeneity of Variances

Neliéhinta
Levene Statistic dfl df2 Sig.
1,929 2 226 ,148
ANOVA
Nelidhinta
Sum of
Squares df Mean Square F Sig.
Between Groups 45699080,58 2 22849540,29 173,035 ,000
Within Groups 29843678,05 226 132051,673
Total 75542758,64 228

Multiple Comparisons

Dependent Variable: Nelithinta
Bonferroni

95% Confidence Interval

() Alue (J) Alue Diffe’;/le?lacre]z (I-J)  Std. Error Sig. Lower Bound  Upper Bound
Keskusta Lansi 983,32022 71,87439 ,000 809,9641 1156,6764
Ita 861,47438* 52,12868 ,000 735,7435 987,2052
Lansi Keskusta -983,32022* 71,87439 ,000 -1156,6764 -809,9641
Ita -121,84584 72,93296 ,289 -297,7552 54,0635
Ita Keskusta —861,47438* 52,12868 ,000 -987,2052 -735,7435
Lansi 121,84584 72,93296 ,289 -54,0635 297,7552

*. The mean difference is significant at the 0.05 level.

Ensin huomataan, ettd ehdolliset otoskeskiarvot niyttédisivit poikkeavan toisistaan
ainakin verrattaessa keskustan keskiarvoja muihin. Kun testataan varianssien yh-
tasuuruutta (kolmessa populaatiossa, tarkastellaan nelidhintaa kolmella alueella),
voidaan olettaa niiden olevat yhtd suuret, koska p = 0,148. Testattaessa odotusarvo-
jen yhtdsuuruutta saadaan F = 173,035 ja p < 0,001, joten Hy hylétédén ja tehddidn
johtopaitelma, ettd kaikilla alueilla nelidhinnat eivit ole keskiméérin samoja. Missd
sitten on eroja? Alueittain vertailu (Multiple Comparisons) kertoo, ettd eroja on
keskustan ja muiden alueiden vililld (p < 0,001), mutta ei idin ja ldnnen vililla

(p = 0,289).
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Esimerkki 17. Halutaan tutkia, vaikuttaako huoneistotyyppi keskiméérdiseen ne-
lichintaan. Koska esimerkissi 10 todettiin keskimadrdisissd nelichinnoissa olevan
eroja keskustassa ja keskustan ulkopuolella, niin tehdidin varianssinalyysi ndissd
ryhmissa erikseen (Data » Split File ...).

Nyt

Hy: neliohinnan odotusarvot ovat samoja huoneistotyypeittdin

Hi: nelichinnan odotusarvot kaikki eivit yhti suuria.

Saadaan tulokset

Nelidhinta

Onko keskustassa? N Mean

Eiole Yksio 18 1876,4512
Kaksio 56 1436,4447
Kaksiota suurempi 52  1446,0183
Total 126  1503,2538

On Yksio 13  2768,6696
Kaksio 58  2339,6051
Kaksiota suurempi 32 2351,9919
Total 103  2397,6072

Test of Homogeneity of Variances

Nelidhinta
Onko keskustassa? Levene Statistic dfl df2 Sig.
Ei ole 214 2 123 ,808
On 1,010 2 100 ,368
ANOVA
Nelidhinta
Sum of
Onko keskustassa? Squares df Mean Square F Sig.
Eiole Between Groups 2927273,954 2 1463636,977 17,472 ,000
Within Groups 10303595,08 123 83769,066
Total 13230869,03 125
On Between Groups 2051644,770 2 1025822,385 6,871 ,002
Within Groups 14929732,24 100 149297,322
Total 16981377,01 102
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Multiple Comparisons

Dependent Variable: Nelidhinta
Bonferroni
Mean 95% Confidence Interval
Onko keskustassa? (I) Huoneisto (J) Huoneisto Difference (I—;]) Std. Error Sig. Lower Bound  Upper Bound
Yksio Kaksio 440,00653 78,42011 ,000 249,6681 630,3449
Kaksiota suurempi 430,43288" 79,15037 ,000 238,3220 622,5438
Kaksio Yksio -440,00653" 78,42011 ,000 -630,3449 -249,6681
Kaksiota suurempi -9,57364 55,73885 1,000 -144,8609 125,7137
Kaksiota suurempi Yksio -430,43288* 79,15037 ,000 -622,5438 -238,3220
Kaksio 9,57364 55,73885 1,000 -125,7137 144,8609
Yksio Kaksio 429,06445* 118,56855 ,001 140,3596 717,7693
Kaksiota suurempi 416,67765  127,08246 ,004 107,2422 726,1131
Kaksio Yksio -429,06445* 118,56855 ,001 -717,7693 -140,3596
Kaksiota suurempi -12,38680 85,08603 1,000 -219,5644 194,7908
Kaksiota suurempi Yksio -416,67765* 127,08246 ,004 -726,1131 -107,2422
Kaksio 12,38680 85,08603 1,000 -194,7908 219,5644

*. The mean difference is significant at the 0.05 level.

Ensin huomataan, ettd sijainnista riippumatta aineistossa yksioiden neliohinnan
keskiarvot niyttdisivit poikkeavan muista. Kun testataan huoneistotyypeittiin va-
rianssien yhtdsuuruutta, voidaan olettaa niiden olevat yhté suuret seka keskustassa
(p = 0,368) ettd keskustan ulkopuolella (p = 0,808). Testattaessa odotusarvojen
yhtdsuuruutta saadaan keskustassa F' = 6,871 ja p = 0,002 ja keskustan ulkopuolel-
la F =17,472 ja p < 0,001, joten molemmissa ryhmissd Hy hylitdin ja tehdain
johtopéatelmit, ettd huoneistopyypeittidin nelichinnat eivit ole keskiméérin samoja.
Missa sitten on eroja? Huoneistotyypeittdin vertailu (Multiple Comparisons) kertoo,
ettd yksiot eroavat muista, mutta kaksioiden ja sitd suurempien vililla ei keski-
maiirdisissd neliohinnoissa ole eroja. Sama pééttely tehddin seké keskustassa ettd
keskustan ulkopuolella olevien asuntojen osalta. [

Jos halutaan selittdd kvantitatiivista muuttujaa kahdella kvalitatiivisella muuttu-
jalla samanaikaisesti, voidaan joissain tilanteissa kayttdd kaksisuuntaista varianssi-
analyysid. Analyysi saadaan tehtya valikosta

Analyze » General Linear Model » Univariate... annetaan selitettiva, riippuva
(Dependent) muuttuja seki selittivit (Fixed Factors) muuttujat.

Kaksisuuntaisessa varianssianalyysissid voidaan tutkia molempien selittidjien oma-
vaikutusta sekd yhdysvaikutusta. Jokaiseen saadaan omat F-testit.

Esimerkki 18. Tehdiin kaksisuuntainen varianssianalyysi huoneistotyypin ja si-
jainnin samanaikaisesta vaikutuksesta keskimiérdiseen nelichintaan. Esimerkin 17
ryhmékeskiarvoista ndhdiin, ettd ne kayttiaytyvit hyvin samalla tavalla huoneisto-
tyypeittidin keskustassa ja keskustan ulkopuolella. Keskiarvojen vertailu voidaan
tehdi graafisesti Graphs » Legacy Dialogs » Line... Multiple pyytiden keskiarvot
Neliohinnasta ja antamalla ryhmittelymuuttujat Category Axis Huoneisto, Define
Lines by Onko keskustassa? Néin saadaan kuvaaja
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Etukiteen voisi ryhmékeskiarvojen perusteella arvioida, ettd yhdysvaikutusta ei
olisi havaittavissa. Tehddin kaksisuuntainen varianssianalyysi ja saadaan tulos

Tests of Between-Subjects Effects

Dependent Variable: Neliéhinta

Type Il Sum of
Source Squares df Mean Square F Sig.
Corrected Model 50309431,3% 5 10061886,26 88,922 ,000
Intercept 684718896,0 1 684718896,0 6051,216 ,000
Huoneisto 4834593,872 2 2417296,936 21,363 ,000
Onko keskustassa? 33464982,52 1 33464982,52 295,747 ,000
Huoneisto * Onko 1047,606 2 523,803 ,005 ,995
keskustassa?
Error 25233327,31 223 113153,934
Total 907041110,3 229
Corrected Total 75542758,64 228

a. R Squared = ,666 (Adjusted R Squared = ,658)

Huomataan, ettd yhdysvaikutukseen liittyvd p = 0,995 (F = 0,005). Paitellaan,

ettd yhdysvaikutusta ei ole.

Esimerkki 19. Vaikuttaako rakennusaika samalla tavalla nelichintaan keskustassa
ja muualla? Ryhmikeskiarvoista nihdiin, ettd ne kdyttaytyvit eri tavalla rakennus-
ajankohdan (luokiteltu Rakennusvuosi-muuttuja) mukaan keskustassa ja keskustan

ulkopuolella.
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Rakennusaika
Niin voisi olla odotettavissa yhdysvaikutusta. Tehddan kaksisuuntainen varianssi-
analyysi ja saadaan tulos

Tests of Between-Subjects Effects

Dependent Variable: Neliéhinta

Type Il Sum of
Source Squares df Mean Square F Sig.
Corrected Model 51473967,7% 7 7353423,957 67,519 ,000
Intercept 699593758,9 1 699593758,9  6423,680 ,000
Onko keskustassa? 34440038,88 1 34440038,88 316,229 ,000
Rakennusaika 4400240,537 3 1466746,846 13,468 ,000
Onko keskustassa? * 2298538,654 3 766179,551 7,035 ,000
Rakennusaika
Error 24068790,94 221 108908,556
Total 907041110,3 229
Corrected Total 75542758,64 228

a. R Squared = ,681 (Adjusted R Squared = ,671)

Huomataan, ettd yhdysvaikutukseen liittyvd p < 0,001 (F = 7,035), joten péitel-
ladn yhdysvaikutusta olevan. My0s molempien muuttujien omavaikutukset ovat
merkitsevid (F = 316,229, p < 0,001, F = 13,468, p < 0,001). ]

6.4 Regressioanalyysi

Regressioanalyysilld tutkitaan muuttujan y riippuvuutta muuttujista xi, xo, ...,
Xi. Pyritdédn 16ytamiin malli, joka kertoisi y:n riippuvuuden selittéjistd. Kaikkien
muuttujien oletetaan olevan kvantitatiivisia. Tosin joissain tilanteissa selittdjissa voi
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olla dikotomisia muuttujia, miké on sitten huomioitava mallin tulkinnassa tietylld
tavalla.

Regressioanalyysin yhteydessi ajatellaan selitettdvan muuttujan y riippuvuuden
muuttujista xj, xp, . .., X;x olevan muotoa

Y = Bo+ Bix1 + Poxy + -+ Prxg + &,

missd ¥ on satunnaismuuttuja (response) selitettivd muuttuja, havaittavissa oleva;
X1, X2, . . ., X; ovat selittivid, ei-satunnaisia, havaittuja, kontrolloitavissa olevia; &
on satunnaismuuttuja, virhetermi (ei havaittavissa oleva), Bo, 81, B2, - . . , Bx ovat
mallin tuntemattomat parametrit, jotka aineiston perusteella ovat estimoitavissa
(arvioitavissa). Jos k = 1, on kyse yhden selittdjidn regressiomallista, jos k = 2
kahden selittdjén, jne. Vakiokerroin 5y voi tarvittaessa puuttua mallista.

Tavanomainen yhden selittijan regressioanalyysi sopii kdytettidviksi lineaarisesti
riippuvien muuttujien yhteydessa. Tilloin pisteparveen voidaan sovittaa suora, jonka
ympidrille pisteiden ajatellaan ryhmittyneen. Tdlloin y:n riippuvuus muuttujasta x
on muotoa

Y =00+ p1x+e

missd So ja B ovat mallin parametrit sekd & satunnaisvirhe. Tassd yhden selittdjan
regressiomallissa ajatellaan siis satunnaismuuttujan Y:n muodostuvan x:n avulla
selitettivistd osasta By + B1x sekid satunnaisvaihtelusta . Jos oletetaan, ettd on
tehty n havaintoa muuttujan x eri arvoilla, niin malli voidaan kirjoittaa muodossa

Yi:B0+ﬁ1xi+8i’ i:l,2,...,n.

Regressiomallissa oletetaan, ettd jokainen &; ~ N(0, o2) ja &;:t ovat riippumattomia.

Mallin estimointi sisdltdd parametrien By ja B estimoinnin. Téssd siis esti-
moidaan suora, jonka ajatellaan kuvaavan y:n riippuvuutta x:std. Estimoitu malli
(suora) on § = By + B x.

Yhden selittdjdn regressioanalyysissi siis estimoidaan pisteparveen sovitettava
suora, suoran vakiokerroin sekd kulmakerroin. Ajatellaan, etti y:n arvot maariytyvit
keskimadrin x:n arvoista estimoidun suoran yhtdlon mukaisesti. Mitd paremmin
pisteet ovat keskittyneet suoran ympdrille, sitd voimakkaampaa on riippuvuus.
Korrelaatiokerroin mittaa titd lineaarisen riippuvuuden voimakkuutta. Otoksesta
laskettua korrelaatiokerrointa kdyttden voidaankin testata, onko populaatiossa
kahden muuttujan vélinen korrelaatiokerroin nolla. Talloin

Hy: populaatiossa muuttujien vilinen korrelaatiokerroin on nolla

H,: populaatiossa muuttujien vilinen korrelaatiokerroin ei ole on nolla.

Téssd kiytetddn testisuuretta, joka noudattaa Studentin 7-jakaumaa. Kun SPSS:114
lasketaan korrelaatiomatriisi (ks. luku 5), niin saadaan samalla tdhan ¢-testiin
liittyvéd p-arvo.

Esimerkki 20. Esimerkissd 11 otoskorrelaatiokerroin rasvaprosentin ja vyoti-
ron ympérysmitan vililld on 0,813. Kun testataan hypoteesia Hy: rasvaprosentti
ja vyotaron ymparysmitta eivit riipu lineaarisesti toisistaan, se hylédtidian, koska
p < 0,001. Lineaarista riippuvuutta siis on ja se voidaan mallittaa suorittamalla
regressioanalyysi (ks. esimerkki 21). [
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Regressioanalyysissd estimoinnin lisdksi suoritetaan erilaisia mallin uskottavuu-
den ja hyvyyden tarkasteluja. Ensimmiisend on selvitettivd, voidaanko estimoitujen
parametrien perusteella péatelld, ettd mallin parametrit ovat nollasta poikkeavia.

Testataan yhden selittdjan mallissa aluksi sitd, onko x merkitsevi selittdja.
Talloin testattavana hypoteesina on

Hy: 51 =0
H]Zﬁl ¢O,

johon saadaan ¢-testisuure. Jos x on todettu merkitseviksi selittdjaksi, niin seuraa-
vaksi voidaan tutkia, onko vakiokertoimen Sy syyti olla mallissa.

Talloin
H()Z ﬁ() =0
Hy: By # 0.

Tédhinkin saadaan 7-testisuure.

Liséksi saadaan laskettua mallin selityskerroin R?. Tlmoittamalla 100R?, voidaan
puhua mallin selitysasteesta. Yhden selittijin regressiomallissa 100R*> = 10072
kertoen kuinka monta prosenttia y:n vaihtelusta kyseiselld yhden selittdjin mallilla
voidaan x:n avulla selittdd. Selityskertoimella on tdma tulkinta kuitenkin vain
silloin, kun mallissa on vakiokerroin.

Regressioanalyysin suoritus tapahtuu valikosta

Analyze » Regression » Linear... annetaan selitettdavd, riippuva (Dependent)
muuttuja seka selittdvi(t), (riippumattomat, Independent(s)) muuttuja(t).

Esimerkki 21. Tarkastellaan rasvaprosentin riippuvuutta vyotiron ympérysmitasta.
Esimerkissi 11 olevasta pisteparvesta nihddin, ettd pisteparveen voidaan sovittaa
suora. Kun suoritetaan regressioanalyysi, saadaan tulokset

Model Summary

Adjusted R Std. Error of the
Model R R Square Square Estimate

1 8132 ,662 ,660 4,877

a. Predictors: (Constant), vyotarén ymparys(cm)

ANOVA?
Sum of
Model Squares df Mean Square F Sig.
1 Regression 11631,527 1 11631,527 488,928 ,OOOb
Residual 5947,463 250 23,790
Total 17578,990 251

a. Dependent Variable: rasvaprosentti

b. Predictors: (Constant), vyétarén ymparys(cm)

Coefficients?

Standardized

Unstandardized Coefficients Coefficients
Model B Std. Error Beta t Sig.
1 (Constant) -39,280 2,660 -14,765 ,000
vyOtaron ymparys(cm) ,631 ,029 ,813 22,112 ,000

a. Dependent Variable: rasvaprosentti
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Tarkasteltava regressiomalli on nyt
Rasvaprosentti = By + 1 Vyotdron ympdrys(cm) + €.
Kun malli on estimoitu, saadaan suora
Rasmntti = —39,280 + 0,631 Vyotdiron ympdrys(cm).

Esimerkiksi vyotaron ympérysmitan ollessa 90 cm rasvaprosentti on keskiméérin
17,51. Siis yhden senttimetrin lisdys nostaa rasvaprosentti keskiméérin 0,631.
Mallissa molemmat kertoimet ovat merkitsevia (¢ = 22,112, p < 0,001;¢ = —14,765,
p < 0,001). Rasvaprosenttia voidaan siis selittdd vyotiron ympéarysmitalla esitetyn
mallin mukaisesti. Lisidksi saadaan selitysprosentiksi 66,2. Vyotdaron ymparys siis
selittdd rasvaprosentista vaihtelusta 66,2 Y%o. [ ]

Useamman selittdjan malliin liittyvit yksittdisten kertoimien testaukset 7-testien
avulla. Talloin tutkitaan sitd, lisddko kyseisen selittdjdn tuonti malliin muiden jo
sielld ollessa mallin selitysastetta riittavasti. Talloin

H()Iﬁi =0
Hy: Bi #0.

Lisdksi testataan F'-testilld kaikkien selittdjien yhteisvaikutusta eli sitd saadaanko y:n
vaihtelua selitettya siten, ettd otetaan kaikki tarkasteltavat selittdjiat samanaikaisesti
malliin mukaan. Tidm4i regressiokertoimien yhteistestaus (kun vakiokerroin on
mallissa mukana) voidaan muotoilla

Ho:ﬁl :ﬁz:-'~:ﬂk:0
Hi: ainakin jokin §; # O.

Mallin valinta ei aina ole kovin helppoa. Pyritdédn valitsemaan niin monta merkit-
sevad selittdjad, ettd selitysaste on mahdollisimman hyvi. On kuitenkin pidettava
mielessa se, ettd mallin on oltava kiyttotarkoitukseensa sopiva ja tulkittavissa oleva.
Vaikka on olemassa erilaisia automaattisia mallinvalintamenettelyji, on niitid syyta
kayttad hyvin harkiten.

Testauksien lisdksi mallin sopivuuden ja hyvyyden tarkasteluihin liittyvit
oletusten, jotka liittyvét satunnaisvirheeseen &, voimassaolon tutkimiset. Niité ei
kuitenkaan késitelld tdassd yhteydessa.

Esimerkki 22. Lisétddn esimerkissd 21 toiseksi selittdjaksi henkilon paino. Saa-
daan tulokset

Model Summary

Adjusted R Std. Error of the
Model R R Square Square Estimate

1 ,848?2 719 717 4,456

a. Predictors: (Constant), Paino_kg, vy6taron ymparys(cm)
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ANOVA?

Sum of
Model Squares df Mean Square F Sig.
1 Regression 12635,745 2 6317,872 318,242 ,000b
Residual 4943,245 249 19,852
Total 17578,990 251

a. Dependent Variable: rasvaprosentti

b. Predictors: (Constant), Paino_kg, vy6tardn ymparys(cm)

Coefficients?®

Standardized
Unstandardized Coefficients Coefficients
Model B Std. Error Beta t Sig.
1 (Constant) -45,952 2,605 -17,640 ,000
vyOtaron ymparys(cm) ,990 ,057 1,275 17,447 ,000
Paino_kg -,326 ,046 -,520 -7,112 ,000

a. Dependent Variable: rasvaprosentti
Tarkasteltava regressiomalli on nyt
Rasvaprosentti = o + 1 Vyotdron ympdrys(cm) + 1 Paino_kg + €.

Estimointituloksen perusteella ndhdidin, ettd yksittdisten kertoimien testauksen
yhteydessa kaikki nollahypoteesit hyladtdédn eli mallin kertoimet ovat merkitsevia
(rt = -17,640, p < 0,001; r = 17,640, p < 0,001; r = =7,112, p < 0,001) ja
selitysprosentti 71,9. Samoin yhteistestauksessa nollahypoteesi hylétiddn (F =
318.242, p < 0,001). Malli on siis kaikin puolin kunnossa ja rasvaprosenttia
voidaan nyt estimoida

Rasmntti = —45,952 + 0,990 Vydétiron ympdrys(cm) — 0,326 Paino_kg.

Esimerkiksi miehilld, joiden vyotiron ympérysmitta on 98 cm ja paino 95 kg,
keskimairin rasvaprosentti on 20,10. ]

7 Lopuksi

Oppaassa tarkasteltiin empiirisen tutkimuksen eri tyovaiheita ja toteutusta SPSS-
ohjelmistolla. Seuraavassa on lyhyesti yhteenveto tutkimuksen tyovaiheista.

Kun havaintoaineisto on hankittu, muokataan se analysointia varten havain-
tomatriisimuotoon. Muuttujien mitta-asteikot on syytd selvittdi, jotta analyysit
tulee oikein valituksi. Havaintomatriisi talletetaan tietokoneelle joko kéytettavalld
tilastolaskentaohjelmistolla tai siten, ettd tami ohjelmisto pystyy sen lukemaan. Tie-
tojen taltioinnin oikeellisuus on syyta tarkistaa. Yleiskuvan saamiseksi aineistosta
analysointi aloitetaan muuttujien jakaumien muodostamisella seki tarpeellisten
tunnuslukujen laskulla. Kaytetdédn tarpeen mukaan tilanteeseen sopivia graafisia
esityksid. Jakaumien teon yhteydessd voidaan 10ytii tallennusvirheiti.

Seuraavaksi on vuorossa varsinainen analysointi. Valitaan kuhunkin tilanteeseen
kiyttokelpoinen menetelmai ja suoritetaan analyysi ja tulkitaan tulokset. Jokaiseen
analysointivaiheeseen kuuluu siis johtopaidtelmien teko. Esimerkiksi aineiston
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kuvailun yhteydessi voidaan kiinnittdd huomio jakauman muotoon. Riippuvuus-
tarkastelujen yhteydessi tehddidn johtopéddtelmia riippuvuussuhteista perustaen
paitelmien teko analysoinnissa saatuihin tuloksiin.

Tilastollisen tutkimuksen keskeisen vaiheen muodostaakin ndiden tutkimus-
tulosten esittiminen sellaisessa kirjallisessa asussa, ettd lukija, jolle tutkimus-
tulokset on tarkoitettu, saa sen sisdltimin informaation mahdollisimman hel-
posti, havainnollisesti ja yksikésitteisessd muodossa. Raportointi on syytd ji-
sennelld selkedsti alaotsikointia ja kappalejakoa kayttden. Kuviot ja taulukot
laaditaan yleisten sopimusten mukaisesti, ne numeroidaan ja otsikoidaan. Ku-
vioiden ja taulukoiden on muodostettava sellaisia itsendisid kokonaisuuksia, ettd
lukija voi muuhun tekstiin turvautumatta ymmaértad niissd esitetyn asian. (ks.
http://www.fsd.uta.fi/menetelmaopetus/raportointi/numerotulokset.html)

Tassd oppaassa kdytettiin vain murto-osaa tarjolla olevista menetelmistd. Mene-
telmat, joita esiteltiin, ovat ehki kaikkein tavanomaisimpia ja useimmiten kaikilla
tilastotieteen perusopintotasoisilla kursseilla esitettyja. Lopuksi vield yhteenveto
ndiden tilastollisten analyysien suorittamisesta SPSS-ohjelmistolla.

Analyze »
Descriptive Statistics » frekvenssijakaumat, tunnusluvut, ristiintaulukot
Compare Means » ¢-testi, yksisuuntainen varianssianalyysi
General Linear Model » kaksisuuntainen varianssianalyysi
Correlate » korrelaatiomatriisi
Regression » regressioanalyysi

Graphs » Legacy Dialogs »
Bar... pylvisdiagrammit
Pie... piirakat
Boxplot... laatikko-jana -kuviot
Scatter... pisteparvet

Histogram... frekvenssihistogrammit

Raportin analyyseissa kaytetyt aineistot

Rasvaprosentti-aineistoa
http://www.sis.uta.fi/tilasto/tiltp_aineistoja/rasvaprosentti.sav,
muuttujien kuvaukset
http://www.sis.uta.fi/tilasto/tiltp_aineistoja/rasvaprosentti.PDF,
lahde
https://ww?2.amstat.org/publications/jse/v4n1/datasets.johnson.html

Asunnot_2006-aineisto
http://www.sis.uta.fi/tilasto/tiltp_aineistoja/Asunnot_2006.sav
Tampereella ETUOVI.com-palvelussa myynnissa olleita kerrostalohuoneis-
toja, jotka olivat esittelyssd 7.—14.4.2006. Mukana on vuosina 1950-2000
rakennetut talot, aineiston kerdnnyt Mika Hannula.
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ARVIO-aineisto
http://www.sis.uta.fi/tilasto/tiltp_aineistoja/arvio.sav,

kyselylomake
http://www.sis.uta.fi/tilasto/tiltp3/kevat2003/Aineistoja/arviointi_lomake.pdf
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